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In the Executive Meeting Notes a reference is made to a new
computer for the club. Ventura County Computers will put one
together that will support multiple operating systems. This machine will be used for both the beginners SIG at the monthly general meeting and the SIGs at Ventura County Computers. This
has a real advantage as the MS Operating systems are not consistent, and differences can be shown with a simple reboot. Recently,
I have been experiencing “Operating System Shock.” I have left
the comfort of Win98 for WinME and Win2000. Change always
interrupts security but is necessary to move forward. Remember, I
moved into the PC world kicking and screaming. I wonder what
it would have been like if UNIX systems were as affordable?
I am going to digress and talk about games, one game in particular. I cannot even remember its name, but my longest encounter with it lasted 32 hours one weekend. I guess I could have been
considered a hardcore gamer. A lot of people could. The game
was removed from the machine as it ran so much after work
hours and on weekends that it interrupted the calculations the
machine was doing. It ran on a Vax1100, I think. The operating
system was Eunice, Dec’s version of UNIX. The year was 1986.
What made this game so appealing was that it never repeated itself and it could not be won. There were no graphics, only defined boundaries on a screen full of symbols. The hero was an
“*,” and potions, charms, scrolls, armor and weapons were all
symbols of one kind or another. The task was to work your way to
the 28th level of the dungeon, recover the ring, and make your
way back to the surface. Once at the surface, who knows what
would happen? I actually never made it. The keyboard was the
interface, your strategy and imagination the real gem. The
TRICK, each time you met demise and restarted, the association
of symbols with objects changed and, even more interesting, the
dungeon layout and monsters on each level changed. It was a totally new game.
Memorization of keystrokes was useless. “Absolute Blind
Luck” was essential. I almost believe that your strategy was
(Continued on page 3)
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Executive Committee Meeting Notes
December 2001 By Martha Churchyard, temporary secretary
The CIPCUG Executive Committee meeting was on
Dec. 4, 2001.
Present: Art Lewis, Toby Scott, Helen Long, Craig
Ladd, Martha Churchyard, George and Arlene Lakes, Andy
Toth, Ken Church, David Minken.
The club needs a new computer for the Beginners’ SIG
and other uses. After discussion, the board approved a motion authorizing up to $1,000 for the purchase of a new
desktop computer from Ventura County Computers. It will
be ready for the January meeting, sooner if possible.
SIGs and general meeting programs were discussed.
Presentations from Belkin and AI 2 are in the process of being scheduled. Everyone agreed that this month’s meeting

using a high-speed Internet connection was very successful.
We hope do another one in the future if the Cowan Center
is available. Toby’s list of useful Web sites will be posted
on his Web site.
The cost of the mailing label program that we share
with two other organizations is increasing from $254.70 to
$279.45 per year. The board approved a motion that the
club pay the full amount for this year now and then bill the
other users.
Arthur Jensen has resumed the job of Librarian, so
members will have the use of the library again.

Why join CIPCUG?
Here are just a few of the reasons: Monthly SIGs, a monthly program, a monthly newsletter, a
discounted Internet Service Provider, a library of computer books and videos, discounts on a
variety of books and software, access to computer help through F1—Your Help Key, friendships with other computer users and the chance to help others with your knowledge.
Page 2
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Coming up: Using a high-speed Net connection
January door prizes

Programs
Don’t forget that we’re back at the regular location — Freedom Center — on Saturday, Jan. 4.
Our program will feature a demonstration of Windows XP, the new Microsoft operating system. Here are
some Microsoft comments on its newest operating system:
Windows XP Professional: The fastest Windows
ever, Windows XP Professional includes networking and
other features that make it ideal for business and advanced home computing. Starts faster. Launches apps
faster. Creates content faster. eTesting’s report confirms
that Windows XP Professional has the speed you need.
Windows XP.
Home Edition: The right operating system for entertainment and home use, Windows XP Home Edition
helps you do more with your computer and the Internet.
Wait less, enjoy more. eTe sting’s report shows Windows
XP performance on key tasks, such as launching applications, roars past previous versions.
Of course, not everyone has been as favorably impressed as Microsoft’s publicity department, so there
could be some difficult questions for the presenter.
Other programs coming up:
Saturday, Feb. 2: MGI, makes of PhotoSuite and
other picture- and video-editing programs.

SIGs
All our Special Interest Groups (with the possible
exception of OS/2 when it resumes) are presented at
Ventura County Computers. From the 101 Freeway, exit
at Telephone, take Telephone south to McGrath, turn left
and go one block. Turn right on Goodyear and then right
again into the second driveway. Unit 117 is the back,
right corner of the industrial building.
The Special Interest Groups (SIGs) are sponsored by
CIPCUG and led by volunteers. There is no charge for
members to attend. Signing up for the class is no longer
necessary as our classrooms are large enough to accommodate our club’s needs.

The door prizes for January will be (1) Hewlett Packard
DeskJet 640C color printer, (2) Logitech Internet Keyboard
and Optical Mouse and (3) Symantec Norton AntiVirus
2002 (they finally arrived).
The Microsoft prizes include Windows XP Professional, a cordless Microsoft Optical Mouse, Money Deluxe
2002, Encarta Reference Library 2002 and a couple of
other minor give -aways.
We have two types of raffle tickets: one for any prizes
offered by the presenter and one for club-provided prizes.
The tickets for the presenter’s prizes are free and limited to
one per member. The tickets for the club-provided prizes
are $1 each, $5 for six tickets, $10 for 13 tickets and $20
for 26 tickets and are available to anyone.

SIG reminders
available by e-mail
To keep members up to date on coming SIGs, Andy
Toth has agreed to offer an e-mail reminder service to club
members. Sign up and he will automatically send you a
reminder about two days before each SIG, indicating the
topic, location, and date.
We hope that this service will remind more people
about coming SIGs. Check the front page of the CIPCUG
Web site in the “Latest Page Revisions” or at the bottom of
the SIG INFORMATION page. Or, if you want to sign up
without going to the Web page, send an e-mail to
<siginfo@cipcug.org> with the subject line “subscribe” to
be placed on the list.

If no moderator is listed, the SIG is not officially scheduled. Check the Web page before you attend to make sure
there will be a moderator.
Here’s the SIG schedule for January:
Thursday, Jan. 17: Mike Strecker — Internet Question
and Answer session.
Tuesday, Jan. 22: Toby Scott — E-mail
Thursday, Jan. 31: Andy Toth — Basic HTML

More about: Command.com
(Continued from page 1)

learned and reinforced as you proceeded to the lower levels.
Just to let you know the time invested, one level had a particular devious monster. It took about three hours to get to
that range of levels. It probably took 25 attempts to defeat
it. The monsters on the next level were even more devious.
Hardcore is an understatement. Yes, one could save games
at various levels and resume them.
Where is this going? Well, this was probably the first
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venture into a sort of Virtual Reality game. In the near future, you may see this capability with incredible graphics.
High speed will soon be defined as 20MHz connections to
the Internet. Just as my grandmother went from the horse
and carriage to a man walking on the moon, we, too, shall
see things that are incomprehensible.
The Holiday Season is upon us. I want to wish you all a
Happy Holiday Season, and prosperous and Healthy New
Year.
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December SIGs, Q&A, program combined
Questions answered and program presented by Toby
Scott
Reported by John Weigle
This is a combined report on the beginners/Internet
SIGs, question-and-answer session and program. The three
blended together because of the high-speed Internet connection in the James F. Cowan Conference Center. The
Beginners and Internet SIGs were combined because no
second room was available at the center. — Editor

Beginners/Internet SIG
Q: Can anyone read your e-mail?
A: The e-letters are posted on the Ventura County Computers Web site <www.vccomputers.com>, which can also
be reached through a link on the CIPCUG site <www.
cipcug.org>.
Q: If I want to add RAM how do I determine the
proper kind?
A: RAM needs to match. If it doesn’t, the computer usually won’t boot. If there are very minor timing problems, it
will boot but will be flaky sometimes. With RAM as cheap
as it is, I’d buy it all at one time rather than trying to match
it.
Q: What’s best, DSL or cable?
A: User-satisfaction surveys at <www.dslreports.com>
show much higher satisfaction with cable than DSL. I’ve
had slightly more problems with cable, but when I’ve called
for help the support from cable has always been far superior.
Q: Which is faster?
A: “The answer is which way is the wind blowing.” My cable
has been slightly faster, but not enough to be significant .
The real key is not how fast the connection is. If I had the
choice of a 1.5-megabit dial- up connection or a 33.6 always-on,
I’d go for the always-on. “The biggest problem with dial- up is that
you have to dial up,” and that’s what takes the time. At work, I
have 12-14 windows open all the time with my always-on connection. I do a lot of writing so I keep a dictionary, thesaurus, search
pages and other pages open. The always-on connection
“tremendously improves the quality of using the Internet.”
Forget the speed differences between cable and DSL. You
want to look for support and a reliable connection. Nothing works
perfectly 100 percent of the time, but you want to be as close to
that as possible.

Q: I send e-mail to many people. Is there a way to
save the addresses as a group so I can send to them
again? Can I retrieve the names from that list to add
more?
A: Some e-mail programs want the names separated by
semicolons and some want them separated by commas, so
first you have to determine which your program uses.
You can easily select names from the address book to
add to the “To“ line or the “BCC“ (blind courtesy copy,
which means you don’t show all the e-mail addresses to
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everyone who gets the e-mail) line.
You can also create groups by going to File > New
Group in Outlook Express.
Q: In shared contacts, the names I put in go to the
main list, too. How can I put a name in just a group and
keep it out of the main list?
A: I don't know of any way to do that (neither did anyone else).
Q: Is Outlook Express in Windows ME?
A: Technically, it’s in Internet Explorer, which means it
is in every version of Windows since Win95, but since the
default installation of Windows includes Internet Explorer,
the answer is basically yes. You can install Windows without IE and Outlook Express, but it’s very hard to install
without it. It is possible. If you want to use a different mail
program, just leave Outlook Express alone and use whatever you want.
Juno, America on Line and CompuServe have their own
mail programs, so you can’t use Outlook Express with
them. Actually, you can now with CompuServe, but it
takes a bit of searching to find out how.
Q: How do I add an address to my address book
when I reply to e-mail?
A: In Outlook Express, go to Tools > Options > Send
and check “Automatically add people I reply to in my Address Book.”
Q: We changed our Internet service provider, and
now all my e-mail goes to my husband. How can I get my
mail to come to me?
A: In Outlook Express go to File > Identities > Add new
identity. Fill in the blanks and follow the instructions to
create a new identity.
Then go to Tools > Accounts > Add > Mail and follow
the instructions.
Then go to your husband’s identity, click on Tools >
Accounts, highlight your e-mail account, > Properties >
Advanced and click on “Leave copes of messages on
server.” This will leave copies of messages on the server so
your new
identity/account setup will get copies.
Don’t confuse Identity with e-mail accounts when you
do this. They are two different things.
Q: I have a floppy with 100 addresses on it. I want to
put them on a new computer, but it will let me do only
one at a time. Each one is a separate text file.
A: It’s better to go to the old machine and copy the
Windows address book (it will have the extension .wab) and
then put it on the new machine. On the new machine, go to
Import and point it to the old file. Don’t export it to individual text files.
Q: If you already have names on the new computer,
will this add to them or replace them?
A: It will add to them.
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More Q&A: E-mail prompts many questions
(Continued from page 4)

Q: I have a contact list in Outlook Express. How is it
related to the Windows address book?
A: The address book is shared with other programs. The
contact list lets you do things like add information or notes
or track meetings with it in Outlook Express. You can
merge names and addresses from either the contact list or
address book. They look similar and have similar functions,
but they work differently.
Outlook information is stored in .ost or .pst files if you
need to copy it.
Q: Can you delete all messages at one time?
A: If you want to empty the Trash every time you close
the program, go to Tools > Options > Maintenance and
click on “Empty messages from the Deleted Items folder on
exit.”
Q: I can’t get Outlook Express to show in Hotmail.
A: Go to To ols > Accounts > Mail > Add and put in
your Hotmail address.
Click Next and see that HTTP servers shows Hotmail.
This creates a Hotmail folder in the list of folders. It
works pretty seamlessly, but it will be slower than using
your regular e-mail.
Be sure to tell the program it’s a Hotmail account.
Outlook Express won’t handle Yahoo mail.
Q: I have a Net Zero logo on the screen and have
changed my provider. How do I delete it?
A: Go to Dial Up Networking in My Computer and delete the folder for that account.
Q: I'm getting e-mail from people I don’t know. How
did they get my address?
A: If you’re getting lots of e-mail from people you don’t
know or from people you do know that just doesn’t look
right, it’s almost certainly the result of a virus. We’ll talk
more about that in the Q&A session.
The session broke here for the business meeting. Then
the regular Q&A began, with Toby showing a home page
he created quickly in HTML consisting of just links to favorite sites. He used the page throughout the Q&A and program to show some of his favorite Internet sites.

Regular Q&A session
A (continued): In the combined SIGs we had just started
discussing viruses.
One of the best sites for virus information is Symantec’s
Antivirus Research Center <www.sarc.com>, which has
lists of the latest viruses, free removal tools for many viruses and instructions on how to delete them manually.
This often requires editing the registry, which isn’t something I recommend for new users.
Almost all the latest viruses are distributed as e-mail
attachments. If you save the attachment to a disk, you have

Photo by Jerry Crocker

GETTING READY: Toby Scott makes premeeting adjustments so he can use the
high-speed Internet connection for the
combined SIGs, Q&A and program portions of the December meeting.

the virus on your computer, but the computer is not infected. The key is not to open attachments.
The first thing most viruses do is send copies of themselves to everyone in your address book, so “not opening
attachments except from friends is a recipe for disaster.”
Your address isn’t likely to be in the address book of
strangers, just people you know, so getting mail from people you know doesn’t automatically mean it’s safe.
We had a machine in the store while I was off, and it
was so unusual that Rick called me at home to tell me about
it. It had six live viruses on it, and Norton Antivirus
stopped after finding 3,600 infected files. Rick finally had
to reinstall Windows because many of the infected files
were DLL files that Windows needs to operate. He got rid
of most of the infections by running Norton Antivirus in
DOS mode.
Q: Why don’t people have antivirus programs on
their computers? They aren’t that expensive.
A: This machine did have Norton Antivirus, but it hadn’t been updated since 1999. If you regularly update your
antivirus definitions and upgrade the program to get the
new engines every couple of years, you “should be reasonably safe.” I've had five or six viruses get into my mail files
that Norton Antivirus didn’t have a fix out for yet, so even
if you’re religious about getting new definitions you can
still get a virus on the computer.
Generally, I keep deleted items and check them when I
get new definitions. I do a full scan on the machine at work
(Continued on page 6)
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More Q&A: Computer suffers massive virus attack
(Continued from page 5)

every night.
Q: Can links in e-mail give you a virus?
A: Not if you have the Windows security patches through
at least August 2000.
Q: When do you get the virus alert?
A: It depends on how you’ve set up the antivirus program.
You have three options in Norton: manual scans only; scan
files when you start to open them, but don’t scan e-mail as it
arrives; or scan e-mail as it arrive s.
Sometimes, the scanning as e-mail arrives doesn’t work.
Norton 2001 establishes its own POP3 server on your computer, downloads your mail to that and then runs the antivirus program before putting the mail on your computer. Sometimes it can’t log on and you have to go back to standard email settings (your POP3 server and user name will be different, just change them back) and download a batch of mail
that way. Then go back to Norton Antivirus and tell it to start
scanning mail as it arrives again.
This isn’t a problem for everyone. Some people have the
program run flawlessly forever. I don’t know what causes the
problem.
Q: I had Go Back on my Gateway computer. It’s in
Norton System Works. Can I install it and then remove
Go Back?
A: Yes, but you can also install System Works without
putting Go Back on in the first place.
Go Back and similar programs let you take your computer
back in time if a new installation messes it up. But there are
down sides. You can’t run FDISK on a hard drive that has
Go Back installed because it changes the boot sectors. If it
works fine for you, it’s fine, but if it doesn’t you can have real
problems fixing them. (Gene Barlow also noted at lunch after the November presentation that Go Back doesn't allow
dual booting either. — Editor)
Q: What about restoring XP?
A: I don’t know. We’ve tried to get XP up and running on several computers and had no luck. ASUS, the world’s largest motherboard manufacturer, doesn’t support XP even though Microsoft says
some of its boards are compatible.
Tech Data, which sells premade computers that we buy some of,
also doesn’t have any recommendations to make it work well. We
had similar responses from two other motherboard manufacturers.
“All of the motherboards are a generation behind” because Microsoft didn’t share the code with them to make the boards work well.
The Tech Data people are “really upset with Microsoft.”
If you have a 500-800 megahertz machine that’s reasonably current, you can probably upgrade to XP without major problems, however.

Q: Someone I know sent me and several other people
change-of-e-mail-address notices. One of the other people
got a virus and thought it came from the person who sent
out the notices. Can a Mac give a virus to a PC?
A: No. Macs are no less prone to vi rus attacks because
they all have vulnerabilities, but the number of hackers trying
Page 6
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ONE OF MANY: Toby showed us a lot of
Web pages during December, including
this one from Ventura County Computers.
That’s Roxie at the upper left and Toby
and Rick at lower right.

to make their names by writing Mac viruses isn’t very big.
Q: I sent e-mail to a dozen people and two of them
with Macs got dozens of copies of it. Why?
A: I don’t know for sure without looking at both machines, but it’s easy for people to set up accounts to leave
mail on the server without realizing it. Most servers keep
messages for some period of time, and some automatically
delete messages after some period. If you delete the message
from your machine, the server thinks you haven’t gotten it so
it downloads it again. You can set your e-mail program to tell
the server to delete messages after they’ve been downloaded.
“The server is dumb and stupid. It does what you tell it to
do.”
To change your settings in Outlook Express, go to Tools >
Accounts > Properties > Advanced and check or uncheck
Leave Copy of Messages On Server.
Q: Some programs let you download just e-mail headers and decide if you want the whole message. If you do,
you download it; if you don't want it, you delete it from
the server without going through the download. Mailwasher is a good one.
A: It’s available at <www.mailwasher.net>. Such programs are also good if you get a problem e-mail that you
can’t download. You can use these programs to delete the
problem message so you can get the rest of your mail.
Q: Do your comments on XP apply to Windows 2000?
A: No. It’s the best operating system Microsoft has produced, as far as I’m concerned, and I use it at work and at
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ALMOST READY:
Mike Strecker,
who was drafted
to be Toby’s keyboarder for the
combined SIGs,
gets ready to
take his spot. This
overall view
shows the room
we used in the
Cowan Conference Center in
December.
Photo by Jerry Crocker

More Q&A: Where do viruses come from?
(Continued from page 6)

home.
Q: Will I have problems using FDISK on Windows
ME with Go Back?
A: Yes. At boot up you’ll have to go to the Go Back
menu and uninstall it.
Q: I got a returned e-mail from someone I had supposedly sent mail to, but I have no idea who the person
is. It was supposedly mail I had sent that couldn’t be delivered.
A: People go to Hotmail and other accounts and harvest
e-mail addresses. It’s hard to know what happened in this
case.
Very often you’ll get e-mail that says “click here to remove your name from this list.” Don’t do it. There’s a one
in 10 chance that you’ll get off that list but a nine in 10
likelihood you’ll be added to a lot of other lists because
you’ve just confirmed that the e-mail address is active.
If you don’t want to see a lot of the mail you’re getting,
set up filters in your e-mail program.
Go to Tools > Messages > Rules, where you have lots of
choices for mail rules.
You can send messages with certain words in the subject lines or from certain people to Trash or other folders
(such as Family). “Teen” in the subject line will screen a lot
of the porno sites, although “sex” and “xxx” don’t work as
well as they once did because the senders have realized
January 2002
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they’re too obvious and don’t use them as much as they
used to.
You can use “opt in” or “opt out” screening.
For instance, you can have all mail go directly to the
Deleted Items folder unless it’s from certain people and
then check the Deleted Items folder periodically to make
sure there’s nothing in it you want. If there is, you have to
add the person’s name to the list of mail to allow. Or you
can have mail from certain people routed to different folders, such as family, and delete all the rest.
If you do this, be sure to check the “stop processing
rules” box on each rule because your last rule should be to
move all the other mail to Deleted Items. If you don’t check
“stop processing rules,” the program will send the mail to
the noted folder first and then move it to Deleted Items
when it reaches the last rule.
The opt-in procedure is to find all the messages that
meet certain specifications and follow the rules.
At this point, the Q&A ended.
After the coffee and doughnut break, Toby started his
program presentation.
But first he pointed out that the screensavers on the
computer he was using (it belongs to his daughter, Jessica)
came from <www.aaathemes.com>.
She picked the world traveler theme, but the site has
several available.
(Continued on page 8)
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More Q&A: What do I do with firewall warning?
(Continued from page 7)

Program
The presentation concentrated on some of the things
that can be done with a high-speed, always-on Internet connection. Toby didn’t get to show every link on his list but
promised to get them posted on the Web (they're at <www.
vccomputers.com/internetsig.cfm>) and are on page 9 of
this issue of TOE).
Before we start, if you have a full-time Internet connection, you want a firewall. Don’t use the Norton Personal
Firewall, which is junk. One of the best firewalls is Zone
Alarm at <www.zonelabs.com>, where you can get either
the free or paid version. The paid version has a few more
bells and whistles, but the free version is satisfactory for
most users. The next best program costs $600 or more and
is meant for servers. There’s a feature in Zone Alarm that
will alert you to updates.
Q: If you have a router with a hardware firewall do
you need another firewall?
A: No.
Q: If Zone Alarm or another firewall tells you someone is trying to hack you, how can you find out who it is?
A: It’s better not to worry about it. The firewall stopped
the attack, and most Internet service providers don’t have
the staff to handle complaints. The last thing you want to
do is get the hacker so angry at you that he intensifies his
efforts with something like a denial of service attack.
One reason you need a firewall is hackers who have
been caught and agreed not to do certain activities again.
But they seek out unprotected computers to store their files
(pornography, viruses, etc.) on. They’ll put Trojans on such
computers so they can tell them when to take certain actions.
Some day an FBI agent might come knocking on the
door of your home or business and announce that the bureau has traced child porn or viruses to your machine and
they need it for evidence even though they know you’re not
involved in the crime. Can you afford to be without your
computer for several years until the trial is over?
“You can’t be always-on without a firewall. If you’re
dialing up, it isn’t much of a risk.”
Q: I have Zone Alarm and get pings. What do they
mean?
A: Pings are requests for information from your computer — basically, “are you there? If so, please respond.”
Pinging will tell you how long it took for the ping to come
back and is often used for tests, but many big users, such as
Microsoft, have turned the function off. You can still ping
Yahoo.
Ping only establishes if a computer exists and can be
reached.
If you want to try it go to a DOS window and type
(without the quotation marks) “ping (nameofsite).”
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If you want to test your computer’s security, go to Gi bson Research at <www.grc.com>, click on Shields Up and
run the test there.
Q: If I don’t have a firewall, what should I watch
for?
A: Most Trojans will be caught by up-to-date antivirus
programs. If yours is older than a 2000 version, I’d get a
new one. Update your definitions regularly, but if you only
update the definitions and don’t get a new program periodically you’ll be using an older engine for the scan, and it
might miss some newer types of viruses. Also, most programs charge for updates after the first year, so buying a
new program isn’t as expensive as it might sound at first.
You also need to check for Windows updates periodically. You can do this from Start > Settings > Windows Update or, in Internet Explorer, from Tools > Windows Updates. You must be signed on to the Internet to do this.
When you reach the Updates page, go to Product Updates
and look for Critical Updates first. “Anytime you see a critical update, get it ... They almost always close some kind of
vulnerability.”
The size of the critical updates download will vary depending on when you last checked. If you’ve never checked
and have anything older than XP, it could be quite large.
Follow the instructions to download and install (installation
is usually automatic for these).
Q: I’ve done this several times and keep getting told
I need the same ones.
A: That normally doesn’t happen. If you think it is happening, check the Installation History on the Microsoft Web
page to compare what you’ve already done and what you’re
being told you need.
“You should be doing the updates like once a month,
something like that.” They’re free. The critical updates will
be rolled into one package, the size of which depends on
when you last got any.
You should also get any ActiveX packages, which are
also security issues.
Some of the updates can be downloaded with others;
some must be downloaded alone. The page will tell you
which is which.
You should also get the Internet Explorer 5.5 Service
Pack 2. Internet Explorer 6 is out, but you don’t really want
it yet. It’s all set up for Microsoft’s new .net operations and
XML authoring, but the .net tools won’t be available until
February or so. IE 6 also does not include Java or Quick
Time, so if you want to use Web sites that use them you’ll
have to download them separately, in which case you have
three sets of hands on your browser and if you need tech
support, you'll probably be in trouble.
The site <www.traceroute.org> will show you how long
it takes information to get from your computer to the one
you’re trying to reach and how many servers it went
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More Q&A: Motherboards and chipsets
(Continued from page 8)

through to do it. It also tells you what’s seen when you’re
pinged. If you have the traceroute program on your computer, you can run it from a DOS window.
If you want to know whether your problem with the
Internet connection is yours, your ISP’s or the Internet’s, go
to Internet Traffic Reports <www.internettrafficreports.
com>, which will show you how all the major servers are
working. The loss of @Home servers the night before our
meeting caused a number or problems on Internet speed
(the company declared bankruptcy).
If you’re considering upgrading to Windows XP, be sure
to check the hardware compatibility list at Microsoft’s site.
Go to <www.microsoft.com/hcl> to be sure your hardware
will run under the new operating system.
Q: How do I determine the best motherboard and
chipset?
A: There’s no way to answer that accurately. By the
time you tested all the boards and chips, the data would be
too old to be meaningful.
Q: What about upgrading BIOS?
A: For a BIOS upgrade you must have the exact match-

ing BIOS and Flash Utility.
If you need a BIOS upgrade, I’d encourage you to have
it done professionally. You can order some upgrade chips,
but in some cases, you might destroy the motherboard by
trying to get the old chip out. Not all BIOSes can be upgraded.
Outlook Express problems? Go to <www.tomsterdam.
com>, which is an excellent example of what one person
can do when he di gs deeply into a single subject.
Q: I've noticed that each time you open a new wi ndow in Internet Explorer (hold the Shift key and click
on the link), it’s not full screen. Can you force it to be
full screen?
A: I don't know of a way.
Finally, if you have a Windows problem, go to the Microsoft Knowledge Base. Microsoft periodically moves and
redesigns the page (it had been redesigned since Toby
looked at it on the Friday before the meeting), but it can be
found by going to <www.microsoft.com> and clicking on
Support. “You can usually find a solution for your problem
here” once you figure out how to use the search engine
properly.

Here’s the list of Toby’s favorite sites
This is the complete list of Web sites that Toby Scott
planned to show us at the December meeting. It’s now part
of the Ventura County Computers site <www.vccomputers.
com> and will be updated periodically. To find it, go to the
site, go to Help and click on My Home Page. — Editor
This page started out as a simple index page for a presentation I made to CIPCUG on Dec. 1, 2001. However, because I had grown increasingly disgruntled with My.Yahoo.
com as a home page as a result of their decision to sell popunder pages (these are ones that come up under the page
you are looking at, so that you see the ad when you close or
minimize the page you are looking at). Pop-unders are so
obnoxious that I have ceased using My.Yahoo as my home
page. I plan to make this page my home page, with links to
all the sites I like and use on a regular basis.
You are welcome to use it as your home page if you like,
or simply as a list of potentially useful links. I'll keep the
graphics, fancy tricks and other junk at an absolute minimum so it loads fast even on a 56K modem.
My Two Favorite Search Engines
Google <http://www.google.com/>
AltaVista <http://www. altavista.com/>
General Research
Research It <http://www.itools.com/research-it/> Dictionary, Foreign Language Dictionaries, Thesaurus, Famil-

iar Quotes, Maps, UPS Package Tracking and more, all in
one place.
Encyclopedia Britannica <http://www.britannica.com/>
If you need an encyclopedia, this is the one.
Library of Congress <http://lcweb.loc.gov/global/
explore.html> I could write a book about the resources to be
found here.
The Awesome List <http://209.8.151.142/awesome.
html> One of the oldest Internet lists, kept up-to-date, with
one man’s list of outstanding web sites.
Hoovers <http://www.hoovers.com/> The best stock
screening tools on the net.
Computer Help
Microsoft Knowledgebase <http://support.microsoft.
com/default.aspx?LN=EN-US> Tricky to use, but it has
tons of information about virtually any problem you might
be having with any version of Windows (yes, even Windows 3.1).
Traceroute Database <http://www.traceroute.org/
#USA> If you have really slow connections and want to
find out where the problem lies, use a traceroute to backtrack to your site. You should see quite easily where the
slow link(s) are.
DSL Reports <http://www.dslreports.com/> The best
site for information regarding DSL and cable modems, in(Continued on page 10)
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More on Toby’s favorite Web sites
(Continued from page 9)

cluding a speed test, tools to change your networking settings to speed up high-speed access and reports on outages
and problems.
Gibson Research Corporation <http://www.grc.com/>
Steve Gibson has an absolutely fabulous site, including a
security check (Shields Up). Be sure to run Shields Up
every couple of months to keep up to date with the latest
hacker ploys.
Internet Traffic Report <http://www.
internettrafficreport.com/cgi - b i n/tr_chartpage.pl?
NorthAmerica> See graphically, where there are problems
on the Internet. Helpful to determine if the problems you
are experiencing are caused by your own provider or are a
wider problem.
Microsoft DLL Help <http://support.microsoft.com/
servicedesks/fileversion/dllinfo.asp?fr=0&sd=msdn> If you
have a problem with a dll file, this is the place to fix it.
Microsoft Download Center <http://www.microsoft.
com/downloads/search.asp> Lots of tools and add-ons for
Microsoft products. Get filters to read Word 2000 files in
Word 97, etc.
HCL <http://www.microsoft.com/hcl/default.asp> Before you change operating systems, be sure to make sure
everything on your system is compatible.

Bob Cerelli’s Site <http://www.onecomputerguy.com/>
Bob Cerelli has been maintaining a help site for Windows
95 and later for ages. He has some of the best tips and tricks
for tuning your version of Windows out there.
Tomsterdam — Outlook Express Help <http://www.
tomsterdam.com/> Outlook Express and only OE, but if you
are having a problem with OE, this is the place to go.
Symantec Antivirus Research Center <http://www.sarc.
com/> A fabulous resource for virus information. Includes
many removal tools for current viruses and you don’t have
to be a Norton AV subscriber to use them.
My Favorite Programs
NoteTab <http://www.notetab.com/> I presented
NoteTab to the club a while back and have done many SIGs
on its features. Absolutely the best text editor out there,
with its own macro language, file management and more.
Photoshop Help <http://www.adobe.com/support/
products/photoshop.html> Adobe’s PhotoShop help site.
Lots of stuff for PhotoShop users.
Real Help
Ventura County Computers <http://www.vccomputers.
com/> What can I say? You’re here so you know it is the
best.

Making a simple Web page
If you want to do what Toby did and make a home page
consisting entirely of links, here’s a sample of the HTML
(Hypertext Markup Language) he used for just the headings
and links on the page he showed us. The coding for the
parts of the page on the VCC Web site that have the contents and images is not included. The page is black type on
white background..
<html>
<head>
<title>Title if you want one (it appears in your browser‘s title
bar, not on the page</title>
</head>
<body>
<p>This page started out as a simple index page for a presentation I (Toby) made to CIPCUG on December 1, 2001. …</p>
<h1>Favorite Sites</h1>
<h3>My Two Favorite Search Engines</h3>
<a href=http://www.google.com>Google</a><BR>
<a href=http://www.altavista.com/>AltaVista</a><BR>
<h3>General Research</h3>
<a href=http://www.itools.com/research-it/>Research It</a>
Dictionary, Foreign Language Dictionaries, Thesaurus, Familiar
Quotes, Maps, UPS Package Tracking and more, all in one place.
<BR>
</body>
</html>
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Continue in this format by cutting and pasting the coding (the material in the less than and greater than brackets)
and substituting the wording you want until you’ve listed
all the sites you want on the page. It is best to do this in a
text editor, but if you do it in a word processor be sure to
save it as DOS or ASCII text, not in the word processor’s
format. Save the document with a .htm or .html extension
and put it in a folder yo u can find again. Go to your
browser and open the page to see if it looks the way you
expected. If it does, set it as your home page. If it doesn’t
look right check your coding.
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Web page: President’s messages available
By Helen Long
<helen@cipcug.org
Why didn’t someone tell me that I hadn’t been posting
the President’s Message? When I finally remembered to
check it out, I found that I had six months of them to post.
Thank goodness I had the Publisher files for all of the
newsletters that John had sent me.
If any of you ever take the time to download the newsletter I do want to brag about Mike Strecker’s page. I had
been doing such a miserable job of scanning it and nothing
I did seemed to improve it. I have not changed my scanning
settings, but I do have WIN ME. I attribute that excellence
to the way ME handles scanning. Probably not correct but
you will have a hard time convincing me the gremlins in
my computer have shifted their interest. Thanks, Rick, for
convincing me to go to ME with the new computer.
Check out the Tech Support Page. I have updated it
with the latest phone numbers for Ventura County and the
San Fernando Valley. When IS-WEST dropped all its 8500
(last four digit) phone numbers it made a few changes in
phone numbers. We have called all the ISP subscribers, but
I now have the correct information on the Tech Support
Page.
Those of you with the club’s ISP service having prob-
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lems with the availability
of the 200-1000 line can
also try the Thousand
Oaks line, 601-0166,
from Camarillo or the
289-1479 from Oxnard as
alternative numbers. We
have been having exceptionally good service, and
in two months I have had
only about four trouble
calls from Oxnard and
Camarillo. Perhaps these
alternative phone numbers will resolve this problem for you.
Craig Ladd has submitted something from the Langa
List concerning a little program called TestRun by Bernie
Built, an Australian. The Langa List reader continues: “It
uses batch files to duplicate the Windows registry, restarts
Windows and then runs any apps you want to test from the
duplicate or ‘dummy registry.’ It has lots of explicit warning screens and prompts, which I find useful. I’ve enjoyed
downloading, using and testing freeware for years. I learned
a lot about Windows systems from my perhaps too naive
(Continued on page 12)
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Safe Mode and bootlog.txt
By Jim Thornton
<jthorn@gte.net>
This article describes what the Safe Mode and the bootlog.txt are and the advantages of using these two items together in resolving your computer’s slow startup time. Part
one explains what the Safe Mode is and how to access it,
while part two introduces the bootlog.txt file and how to
use it in identifying the load times of your computer’s drivers and which ones have failed to load. Drivers are the unseen hardware program files that improve the performance
and features of your computer.
Have you ever seen your computer in its “Safe Mode”?
Safe Mode is a special diagnostic tool available in Windows 95, 98, Me, and 2000 and is easily identified by the
words Safe Mode appearing in each of the four corners of
your monitor’s screen. In addition, your desktop will most
likely run and look different, it will appear to be slower and
the icons may be larger (because of a screen resolution of
640 x 480 pixels) with fewer colors (only 16 colors instead
256 or higher). Note: Being in the Safe Mode does not protect your computer against viruses or hackers.
The reason for the different appearance is that when
Windows boots up in the Safe Mode, all of its startup files
and hardware drivers will be skipped (not loaded). Only
the most basic keyboard, mouse, and VGA (Video Graphics
Adapter) drivers will be loaded. Your CD-ROM (if you are
using Windows 95) and your parallel, serial, and USB
(Universal Serial Bus) ports will be unavailable. If you are
using your PS/2 keyboard and mouse, you won’t have any
keyboard and mouse problems in the Safe Mode; in contrast, if you are using a USB keyboard or mouse, you may
find that they are not working. This might be a good reason
to keep your old PS/2 (non-USB) keyboard and mouse
whenever you upgrade to USB. Some of the newer USB
keyboards and mice have a second cord connector (PS/2)
and if both connectors are plugged into your computer,
your keyboard or mouse will continue to function without
its enhanced features whenever you are in the Safe Mode or
you have a USB problem.
By loading only the most basic drivers, your problemisolating and -resolving capabilities will be greatly enhanced. For example, suppose you installed a new driver
for your video card, but when you rebooted, your monitor

More on Web page
(Continued from page 11)

method of ‘just try it.’ I did install TestRun myself, and it is
very easy to use. I installed a couple of applications while
using it, and switching between Registry and CopyofRegistry and I like it. — Greg.” The site is
<http://testrun.cjb.net/>.
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screen went black and remained dark even through you rebooted numerous times. Without a screen, there is no way
you can find your way to your Device Manager to disable or
uninstall the offending driver.
How can you correct this? Very simply, just manually
go into the Safe Mode and after Windows finishes loading,
go to your System Properties window (depress together the
Windows and the Pause/Break keys), click on the Device
Manager tab, double-click on Display Adapters, highlight
your adapter, and uncheck the “Exists in all hardware profiles” box. Next click on OK and reboot. Now your computer will boot up with a workable video driver and your
desktop will reappear. Either keep this default setting or
install the proper driver. An alternate method would be to
click on the Remove box after you have highlighted your
adapter, click on OK and on OK again, and reboot. Now
Windows will “see” your adapter as a new hardware device
and will install its default Windows’ video driver.

How do you get into the Safe Mode?
Windows 95 — Depress the F5 key at startup, right before the Windows graphics screen come up. Some technicians suggest that you should start tapping the F5 key during startup to make sure that you get to the Microsoft Windows Startup (MWS) menu. On some computers, you may
need to depress the F8 or Ctrl key instead of the F5. Once
the MWS menu appears, enter the number from the menu
for the Safe Mode, and press Enter.
Windows 98 or Me — Depress or continue to tap the
Ctrl key until the MWS menu appears. On some computers, you may need to press the F8 key. Type the number for
the Safe Mode and press Enter.
Windows 95, 98, or Me — Another easy way to go into
the Safe Mode is to use your Windows startup diskette,
sometimes called your emergency boot diskette. Insert your
startup diskette into your drive A and reboot. Depending on
the version of Windows, you will see the drive A prompt;
type in “C:” (without the quotation marks) and depress the
Enter key. Next you’ll see the C drive prompt; change directories to your Windows directory by typing “CD \Windows” and depress Enter. At the C:\Windows prompt, type
“win /b” and depress Enter. Once the MWS menu appears,
enter the number for the Safe Mode, and press Enter. On
the later versions of Windows, especially Windows Me, for
example, you will need to use “win /d:m” instead of “win /
b”. The best solution for your computer is to type, at the C:
\Windows prompt, “win /?” and Enter, then select the appropriate switch (/b, /d:m, etc.) for your computer from the
displayed choices. Also, in some versions of Windows, an
intermediate menu may appear asking if you want to use
your CD drive, etc., in these cases, just select the Minimal
Boot option.
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More on Safe Mode, bootlog.txt
(Continued from page 12)

Windows 2000 — During the normal startup, watch for
the special Troubleshooting and Advanced Startup Options
message to appear, then press the F8 key. Type the number
for the Safe Mode and press Enter.
Windows NT — Refer to Document 294 in your User
Manual, for instructions “How to Boot Windows to VGA
mode.”
Safe Mode also has other advantages besides problem
resolutions. I always run Windows’ Disk Defragmenter in
the Safe Mode, as it completes faster than in the Windows’
normal mode. Norton Utilities’ SpeedDisk (Norton’s ve rsion of Disk Defragmenter) won’t run in the Safe Mode,
while Microsoft’s Disk Defragmenter will run in the normal Windows, in the Safe Mode, and in the DOS mode.

Bootlog.txt and how to use it
This part of the article introduces the use of the Boot
Log Analyzer, enabling you to read your bootlog.txt file in
order to identify drivers that are either slowing down your
startup time or that are failing to load.
Windows creates a special helpful file (bootlog.txt) upon
request during normal startup; it will be placed in your root
directory. This text file faithfully records the loading or
failure to load of each driver.
You will want the most current version of your bootlog.
txt file; thus, you will need to restart your computer as if
you were going into the Safe Mode. From the MWS menu,
enter the number for Logged (\Bootlog.txt), and press Enter. Now Windows, for this session only, will record the
current driver loading activity into its bootlog.txt file and
save its previous version as bootlog.prv. After Windows is
loaded, you will need to make the hidden (invisible) bootlog.txt file viewable. Click on My Computer from your
Desktop, Tools from the Menu bar, Folder Options from the
pulldown menu, the View tab, Options, Show All Files, and
finally OK. Now you can view and print out your bootlog.
txt file by using Notepad, Wordpad, or any similar wordprocessing program. Another easy way to find a hidden file
is to use Windows Explorer’s Search function.
The bootlog.txt is a large file; for example, my bootlog.
txt file is over 20 pages long. The file identifies each driver

as it loaded and whether or not the load was successful. A
typical entry will read: “[00092E23] Initing esdi_506.pdr”
and the next line reads: “[00092E3B] Init Success
esdi_506.pdr”. With a bad entry, the second line would
read: “[00092E3B] Init Failed esdi_506.pdr”. This latter
example would indicate that you had a driver that didn’t
load and that there was a problem. You would want to
search your bootlog.txt file and identify all such failed statements.
With entries like this, how can you determine the
amount of time it takes to load a driver? The problem is
you can’t. However, there is a freeware program called
“Boot Log Analyzer” (version 1.22) that produces a more
readable copy of your bootlog.txt file by adding column titles (Time, Duration, and Event) and by sorting the numerous entries by the loading time in ascending order. The
loading time of each driver is displayed in milliseconds
(thousandths of a second). What you want to look for is
any driver that failed to load or took an abnormally long
time. Generally speaking, each driver should load in less
than seven seconds. Other features of the program are that
you may display only the drivers that were slow, failed to
load, or both; save the file, or search for specific entries.
The Boot Log Analyzer is available from <www.vision4.
dial.pipex.com>.
Should you discover any slow loading drivers or failures, you will want to resolve these problems to improve the
performance of your computer. You may seek the advice of
your favorite service technician or an easier way is to use
the Internet to search for solutions. Use your search engine
of choice and type in the name of the driver that failed or
was slow. From our previous example, you would type in
“esdi_506.pdr” and read the numerous responses. Frequently, you will see read a response and solution directly
from the developer of the driver. In fact, in this example,
the first document found was one from Microsoft’s Product
Support Services titled “ScanDisk Errors on IDE Hard
Disks Larger Than 32 GB,” and this document describes
the problem and provides a remedy.
Note: All the instructions given in this article were
tested on a Windows Me computer; earlier versions of Windows may be respond slightly differently.

These files can be dangerous
Certain files that arrive as e-mail attachments are especially dangerous. Here, from Harley Hahn’s latest book,
“Internet Insecurity,” is a list of the extensions that identify
files that can contain a virus or other program:
.bat — batch file
.chm — compiled HTML file
.com — program
.exe — program
.htm — HTML file
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.html — HTML file
.js — JScript program
.jse — encoded JScript program
.lnk — Windows shortcut (link)
.pif — program infor mation file
.vbs — VBScript program
.vbe — encoded VBScrpt program
.wsf — Windows Script File program
.wsh— Windows Scripting Host Settings File
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Membership report: Is it time to renew?
By Ken Church

January 2002 renewals due:

<membership@cipcug.org>

Total membership: 331
RENEWAL INFORMATION: The renewal dues are $25 for single membership,
$30 for two or more family membership.
Please send renewal payments to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the January meeting.
Nov. 2001 renewals past due, Final Notice:
Mbr #
0516
0738
1041

Last Name
Cantarini
Dutro
Hubbard

First Name Pd to Date
Billy
200111
Georgia
200111
Yvonne
200111

December 2001 renewals due:
Mbr #
0829
1042
1000
0644
0390
0643
0825
0171
0828
0827
0910
0645
0125
0650

Last Name
Bates
Connors
Grether
Hochberger
Kelly
Kinoshita
Pinkerton
Ranson
Rosenbloom
Rosenbloom
Smitley
Wallace
Zakas
Zakas

January 2002

First Name Pd to Date
Don
200112
Timothy D.
200112
Arline
200112
Lyle
200112
Bob
200112
George
200112
Ron
200112
Stan
200112
Jean
200112
Richard
200112
Lee
200112
Sandra
200112
Len
200112
Trish
200112
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Mbr # Last Name
0544 Beardshear

First Name Pd to Date
Paul
200201

0835
0956
1003
0654

Brown
Buford
Casey
Cayou

George
Don L.
Richard
Mylo

Mbr #
0948
0547
0548
0053
0947
0054S
0088
0647
0754
0551
0552
0953
0540
0175
0757
0056
0126
0554
0753
0834
1008
0950
0840
0839
0836S
0557

Last Name
Cordeiro
Creasap
De Magri
Dedeaux
Ellis
Erickson
Gandin
Harte
Harvey
Hernandez
Hernandez
Hill
Jennings
Lee
MacArthur
Malinowski
Manning
Muskat
Otterson
Oxman
Perko
Skultety
Waterman
Waterman
Willett
Wilson

First Name Pd to Date
Frank
200201
Barry
200201
Oscoe
200201
Gene
200201
Dick
200201
Elden
200201
Dr.Morris
200201
Maureen
200201
Harmond
200201
Anselmo
200201
Susan
200201
Keith F.
200201
Clay
200201
Michael
200201
James
200201
Roy
200201
Don
200201
Vel
200201
Dick
200201
Howard
200201
John
200201
Tony
200201
Ginnette
200201
Marc
200201
Dr. Nancy
200201
Woody
200201

200201
200201
200201
200201

Happy Holidays and warm wishes
for the New Year.

Page 15

Return to vendor
By Bruce Pechman
<bigbruce11@hotmail.com>
Atlanta PC Users Group
Reprinted courtesy of APCUG
With holiday gift season encroaching upon us with unrelenting fervor, what better time to examine and evaluate
the collective return policies from major national retailers?
For this article, I excluded Web purchases, as Internet buying invokes another set of circumstances (except for
shipping issues and small print, the policies should remain
comparable). Whether you’re on the receiving or giving
end of computer-related software or hardware this holiday
season, it’s a prudent investment to know your return rights
at prevailing retailers.
Before delving any further, let me state that returns of
“computer software and computer related hardware electronics” can be a very thorny affair, with your rights varying from state to state and store to store.

period and with a sales receipt. Be aware of unreasonable restocking fees that can come back to bite you. Can
you imagine paying a 15 percent restocking charge on a
$2,000 computer you decided you didn’t like five days
later because the keyboard was not right for you? Well,
if you purchased that computer at CompUSA you would
have just flushed $300 down the toilet — that is an expensive “oops.”
One last caveat — with the exception of the week
after Christmas, all major retailers will require an original receipt and valid ID for returns or adjustments. That
said, here are four large national chain’s return policies
ranked from best to worst. As return policies are subject
to change and modification without prior notice, these
are the store policies in writing as of November 2001.
1. BestBuy: This retailer is in the number one spot
for several reasons. Aside from having great prices, it
(Continued on page 18)

Furthermore, it is not uncommon for these hi-tech returns to fall under the “gray area” of such policies and established laws. In particular, if you buy software and decide
you are unhappy with the product for any reason, you could
be in for a “sorry, all sales are final attitude” from your retailer. There are two sides of the coin on this rather sticky
situation. The retailer takes an inflexible stance for several
reasons, but the prevailing justification is the illegal copying of media thanks in part to CD-RW drives costing
around $100. Not everyone agrees with this methodology.
“Bad Software” is a book by Cem Kaner and David L. Pels
about getting your money’s worth when you buy computer
software. The book is written to assist you with getting a
refund, support, or compensation for significant losses
caused by defective software. As I said — it’s a gray area.
If the software does not perform as claimed or is bugridden, should you have to bear the loss? You can demand,
and sometimes get, a refund from where you bought the
software, but you better visit the Web site <badsoftware.
com> or buy the book prior to doing battle. Another path is
to review the software box and see if the software maker
directly warrants a MBG for 30, 60, or 90 days. Remember,
software is not like a jacket you can try on … there is no
way to know in advance if the software will adequately
cover your needs or is buggy by just reading the side panel
of the box. Fortunately, if the software is unopened and
sealed, most retailers will gladly accept the return with a
sales receipt within a specified period of time.
When it comes to hardware and electronics it’s more of
a black-and-white world of delineated guidelines. With the
exception of the increasingly popular 15 percent or higher
open box or “restocking” fees, your rights are reasonably
negotiable for exchange, refund, or credit within a 30-day
Page 16
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HTML

TS

NETWORKS

TS

OS/2

LZ

SPREADSHEETS
Lotus 1 -2-3
Microsoft Excel
Quattro Pro

F1—Your Help Key
(Revised Dec. 11, 2000)
CIPCUG INTERNET SERVICE
(For general Internet and Communications programs,
see Communications/Internet)
Jerry Crocker,
486-0308, 6-10 p.m.
normsplumb@aol.com,
Roland Fleig,
983-8707, mornings
schwable@cipcug.org,
George & Arline Lakes, 983-2969, 2-10 p.m.
thelakes@cipcug.org,
Helen Long
642-6521
helen@cipcug.org
David D. Minkin,
484-2974, 5-12 p.m., weekends
dddave@compuserve.com,
Claude Whelchel,
482-4017, 8-12 a.m.
claude@cipcug.org
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web DM, TS
Compuserve.
DM
Note Tab Pro.
TS
Procomm Plus
DM, WB
DATABASES
dBASE.
MS Access

GM
LP

DOS

RP

GM
DM, LP
DM

UTILITY PROGRAMS
Norton Utilities
PCAnywhere
PC Tools .
XTree Gold.

DM, JD
DM
WB
DM

WORD PROCESSING
Microsoft Word
WordPerfect.

BW, DM, MR
DM, GM, JD

WINDOWS
Windows 3.1
Windows 98, 95
Windows 2000
Windows NT

DM, JM
DM, JM
TS
TS

Initials
BW
DM
GM
JD
JM
LP

Name
Bart Wood
David Minkin
d: voice mail
Gracia Marks
John Daily
Jerry McCloud
Laura Pacheco

(805)
482-4993 (e)
484-2974 (e);
339- 1729
484-7572 (e)
650-0029 (b)
(818) 889-6176 (e)
L5Enigma@Earthlink.net

LZ
MR
RP
TL
TS

Len Zakas
388-8452 (b)
Marvin Reeber
984-1974 (b)
Robert Provart
498-8477 (b)
Terry Lee
tdlee28@hotmail.com
Toby Scott
289-3960 (d)
tech@cipcug.org
TZ
Trish Zakas
388-8452 (b)
WB
Dr. William Burger 653-6889 (e)
Phone: (d) = days; (e) = evenings; (b) = both

EDUCATIONAL / CHILDREN TZ
E-MAIL
Lotus:CCMail.
Outlook
Outlook Express

DM
TS
TS

FINANCIAL
Quicken

JD

GENEALOGY

TL

HARDWARE, UPGRADING JM, JD
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More Return to vendor
(Continued from page 16)

Are you tired of looking at all the ads on your
free Internet or free E-mail service? Are you looking for a reliable ISP at a reasonable price? How
does $15 per month plus $15 processing fee
sound to you? You will also have the advantage
of a special DOMAIN name; however, it may not
be a name of your own choosing. It is the name of
the club that provides this service to its members;
CIPCUG.
To sign up, contact one of the club’s techies in
the F1 — YOUR HELP KEY (page 17) under
CIPCUG INTERNET SERVICE. Call one of
them you may know or one in your area and they
will be glad to provide you with the details necessary for signing up. Checks should be made payable to CIPCUG and forwarded to Treasurer, c/o
CIPCUG, P. O. Box 51354, Oxnard CA 93031.
Don’t forget to include the $15 set-up fee in your
first sign-up check. You may make payments in
three-month, six-month or annual increments.
(Renewals can also be mailed to Treasurer; just be
sure to mention the dates that your check is to
cover).
We have had over a year of flawless service to
our club members. There is no program to install,
you will be making use of the programs that are
already on your computer. It is a simple matter to
talk you through the set-up as it is today — much
easier than it was in the past. If you are the least
bit timid about setting up your computer for our
service, a club member will be glad to come to
your house and make the necessary set up arrangements. How many ISPs do you know who
will do this? Our agreement will also give you a 5
MB Web page allowance.
If you have any questions, please don’t hesitate
to call any of the Tech Support team and they will
either answer the questions or find out the answers for you.
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also claims the least restrictive return policy of merchants
in this group. BestBuy usually is first to have new product
releases on its shelves. Although it sometimes charges a 15
percent restocking fee (unless defective), it’s only applicable to notebook computers, camcorders and digital cameras.
2. Circuit City: Circuit City’s 15 percent restocking fee
extends to all computers, monitors, and printers. Now here
is its gray area: “and related merchandise.” This statement
is open to interpretation, but generally I have found grieving my case in a diplomatic manner to the store manager
can be fruitful. Circuit City prices can be less competitive
on some items so keep an eye on its circular advertisements
to get the best deals.
3. CompUSA: This retailer plays hardball on any return. It is not quite as nasty as Media Play, but it will even
soak you for a 15 percent “Open Box Fee” for a $20 joystick. The CompUSA “Open Box Fee” goes as far to state:
“…on ANY open item.” In other words if you opened it
and return it — you getting zonked for 15 percent of the
purchase price!
4. Media Play: Media Play is just flat out malevolent
when it comes to returns. Read the back of a Media Play
receipt some time. Notice the first sentence: “All returns
are subject to management approval.” In other words, management can deny your return of any product at any time
for any reason. How subjective is this policy? So if the store
manager is having a bad day, he or she just says, “you can’t
return that.” I have also found its prices to be very uncompetitive. If you buy anything at Media Play I have two
words of advice for you … buyer beware. I avoid this retailer like the plague!
Some helpful tips do help your “happy returns” go a
little smoother at holiday season. Always try to keep the
original bag, box, receipt, and packaging if opened. Always
be as pleasant and cheery to your returns clerk as possible:
“Oh, gosh, where did you ever get that shirt with the embroidered Elvis rhinestones — I love Elvis, too! Now about
this camcorder…” Happy Returns!
(There is no restriction against any non-profit group
using the article as long as it is kept in context, with proper
credit given to the author. This article is brought to you by
the Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an International organization to which this user group belongs.)
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Practice safe computing:

Back up

Back up

Back up
January 2002

Editor’s corner:
UNFINISHED BUSINESS: At the November meeting,
a member asked what SMART stands for in relation to
hard drives. Toby couldn’t remember the meaning of the
acronym, and I couldn’t find it quickly in any of my references, even though my hard drive has the capability. Then
the January issue of Smart Computing magazine showed up
with a review of a product (DiskAlert) that uses SMART.
SMART is Self-Monitoring Analysis and Reporting
Technology, which, the magazine says, “notices preliminary symptoms of drive failure.” The problem, the article
continues, is that “many users lack the software that lets
them hear its cries for help.”
The $99.95 program supposedly does, at least on
WinNT/2000/XP, although it’s hard to know how one
would be sure of that until a drive started to fail.
Anyway, there’s the answer.
MICROSOFT: It appears that the suit against Microsoft is either of little interest to our members or they have
no opinions on it. Only one of you responded to my two
requests for thoughts on the matter.
For what’s it worth, I question that the Justice Department should have gotten involved in the whole affair. Microsoft was doing what most big companies want to do:
Drive out the competitors and capture the major portion of
their market.
And, while I’m glad there is competition, I can’t help
but wonder what the PC world would be like if, for instance, six software companies had equal shares of the operating system market.
How popular would computers be if we not only had to
pick what word processor, spread sheet or database programs we wanted to use but also had to decide on an operating system and then determine which programs worked
on it?
And what if the computer at work had a different operating system than the one at home or on your laptop?
Would you be able to take the work home or on the road
with you? (Of course, on second thought, there might be a
tremendous advantage if you couldn’t.) Would all our employers be willing to buy us computers that ran the operating system they liked just so we could work at home? I
doubt it. As it happens, I’m in that situation: We use Macs
at work, and I have a PC at home. Do I want a Mac? No
way. )
Does this mean that Microsoft’s business practices
couldn’t be improved? Of course not. But whether the government, through the courts, can or should try to make the
improvements is another matter. Personally, I don’t think
so.
First, technology moves faster than the executive and
judicial branches have ever been able to. By the time the
“corrections” were made, they might not even be needed.
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Second, the government has not shown it’s especially adept
at running businesses of any kind — and many of the regulations it’s attempted, such as in cable TV and long distance phone systems, didn’t accomplish what was promised. But I’m straying into political realms where this column probably shouldn’t go …
HAPPY HOLIDAYS: It’s that time of year when a
whole series of religious and secular holidays fill the calendar. Whatever you celebrate, I hope you enjoy it and have
one of the best new years ever, filled with whatever you
hope for: health, wealth, success — or peace on earth.
May your computers not crash, your software work as
expected, your ISP keep your connections open when you
want them and your utility programs protect you from
whatever gremlins try to attack your computer.

Happy
holidays
happy new year!

and

— John Weigle, Editor

Treasurer’s report
November 2001

By Art Lewis

<treasurer@cipcug.org>
Category Description
Income
Advertising
ISP Income
New Members
Raffle
Renewals
Software Sales
TOTAL INCOME
EXPENSES
Coffee-Doughnuts
Equipment
ISP Expense
Storage
TOE
TOTAL EXPENSES
TOTAL INCOME – EXPENSES
Unrestricted Funds
Restricted Funds
Bank Balance 11-30

11-1 through
11-30 2001
$ 90.00
240.00
140.00
-79.05
540.00
35.00
966.00

2.45
416.23
424.00
45.00
557.39
1,445.07
-479.07
$6,739.10
1,879.00
8,618.10
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Saturday morning, Jan. 5,
at
Freedom Center,
Camarillo Airport
515 Eubanks (at Pleasant Valley Road)
Camarillo, Calif.
Meeting Schedule:
0845-0930 Beginners SIG
0845-0930 Internet SIGs
0930-0945 Business Meeting
0945-1030 Q&A Session
1030-1055 Break - Please contribute requested
amounts for coffee & doughnuts
1100-1200 Program: Windows XP
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